
 
 
 

 
Audio Web Conferencing – Elluminate Live and Skype 

Guidelines for Use 
 

UNITAR will use Audio Web Conferencing (AWC) to let Mentors and Fellows speak and communicate with 
each other in real time during their computer lab/work-sessions.  This document contains a description and basic 
instructions for AWC.  UNITAR will conduct a hands-on orientation during the May Launch in Kabul on 
installation and use of audio tools. If Fellows find that they want to learn other features, a detailed guide can be 
sent later. 
 
Recommendations and Feedback from the 2007 Fellowship Cycle 
 
Improving effectiveness of the VCs and AWCs as project meetings:  
• Fellows should submit their most recent version of documents to be discussed at least a few days in advance of 

the VC/AWC in order for the Mentors to have the opportunity to review and prepare;  
• Coaches should ensure that they prepare an agenda with the group of what they want to cover in the meeting, 

and should have a list of questions that they want to ask; 
• Mentors should read assignments prior to a VC or AWC to give feedback. 
 
Training on how to use the AWC as a substantive opportunity for training:  
• The Coach or Mentor has to have a proactive agenda and should run the session like a class;  
• During each session, one Fellow should be asked to make a formal 5 minute presentation on the team 

project/assignment as well as list the questions that the group needs to address;  
• The Mentor(s) and Coach should be encouraged to jointly identify topics of interest or relevance to the group 

that periodically could be addressed by the Mentor(s) in brief lectures. 
 
Mentor-Coach Coordination: 
Five minutes in each session should be set aside for Coaches to talk with Mentors and UNITAR about the 
group's dynamics and state of advancement                                                                                            
 
 
 
Elluminate Live 
 
Sources:  
Elluminate Live Quick Reference Guide for Participants 
Elluminate Live User Guide for Participants  
©2001-2007 Elluminate, Inc. All Rights Reserved. 
 
Description 
 
“Elluminate Live” is the software used for UNITAR’s Audio Web Conferencing.  It gives participants the ability 
to talk over the Internet (with full, 2-way audio), chat online, share video, whiteboards, multimedia files and 
applications. It is easy to set up, easy to use and customizable. 
 
For the purposes of the Fellowship we will be mainly using the audio-communication tools. 
 
When using Elluminate Live, you have access to four main windows: 
 
1)    Participant Info Window - provides a list of everyone in the session and their privileges. Privileges include 
speaking, sending direct messages, using the whiteboard, and the video webcam. 
2)     Direct Messaging Window - where you send and receive text messages. You can direct your messages to 
the moderator, one participant, selected participants, or to everyone in the session. 



 
 
 
                                                                  

 

3)     Audio Window - lets you participate in conversations during the session. Your computer must have a sound 
card, microphone and headset (or speakers) to use the audio feature. Headsets/earphones are the preferred option. 
4)     Whiteboard is the main presentation window.  It can be used to view presentations and the tools on the 
whiteboard can be used to draw or write. You can print the whiteboard screens or save them to a file to review 
later. 
 

 
 
 
Use of Audio-Web Conferencing 
 
The following tips and practices will help make AWC sessions effective: 
 
Preparation 
• Ensure that your audio is working correctly prior to your session. 
• Take the Elluminate Live! Online Orientation or refer to the Elluminate Live! Participant Guide for more 

information on all the features prior to your first session. This information and more is available from 
Elluminate’s Support Web page at http://www.elluminate.com/support/, 

 
In-Session 
• Be sure to join the session 5 – 10 minutes prior to the start. 
• Set your Connection Speed to the Internet. 
• Use the Audio Setup utility to test out your microphone and speakers. 
• Participate in the session by responding to polls and providing feedback to the moderator. 
• Remember to raise your hand when you have a question or a comment. 
• Use Direct Messaging to send messages to other participants and the moderator during the session. 
• Remember that running other applications on your computer (such as an Internet browser) can slow your 

connection. 
 
The Section below is relevant if you are using a personal computer at home or office. At any other labs (made 
available to Fellows for use by UNITAR partners) the installation will be done on all computers in advance. 
 
How to Install 
 
In order to attend an AWC session, you will need to follow these steps: 
 
Getting Ready 
• Ensure that the computer on which you will attend the session is connected to the Internet. 
• Ensure that you have a microphone and speakers hooked up to the computer. 
• Ensure that you will be able to install software on your computer. 



 
 
 
                                                                  

 

 
Step One: Installing Java Web Start 
• Go to the following Web page: http://www.elluminate.com/support/supportsoftwaredownload.jsp 
• Click on the button labeled “Download and Install the Required Software” 

o Click “yes” if you see a security warning that asks “Do you want to install and run…Java Plug-in…” 
o When you see the License Agreement, click “I accept the terms in the license and agreement” and 

click Next. 
o Select the Typical installation 

•  When the installation is finished, Java Web Start is ready to use.  
 
Step Two: Installing and Testing Elluminate Live 
• Go to the following Web page: http://www.elluminate.com/support/supportsoftwaredownload.jsp 
• Click on the button labeled Start Elluminate Live 

o Enter your first name on the sign in page. 
o During the installation you may see a security warning that states “This application is requesting 

unrestricted access to your local machine and network.’ Click Start. 
o You may see a License Agreement. Click on I Agree. 

• Once you are in the Configuration Session, follow the directions displayed on the whiteboard. 
• When complete, choose Exit from the File menu. 
You have now installed and configured Elluminate Live and can now join any future session without further 
configuration. 
 
Sound Testing 
 
To use the audio feature, your computer must have a sound card, microphone and speakers (or a headset).  Before 
joining a session or meeting, you should ensure that your audio is configured correctly. 
 
To choose the audio source that you will use, click on the option “Select Audio Source” from the Tools menu.  
Normally, your microphone will be selected by default.  If you would like to use a different audio source, you can 
select it in this dialog box. This is useful in sending the sound from an audio or video clip. 
 
To test and configure your audio at anytime during your session choose “Set Up Audio...” from the Tools menu. 
A series of panels will guide you through the steps: 
 
1. A short recording will be played which will allow you to adjust your speaker volume. 
2. You will be prompted to speak into your microphone to test your microphone recording level.  
 
This will be recorded and played back to you to ensure that your microphone is working and is set to the 
appropriate level. 
 
---------------------------------------------------------------------------------- 
 
 



 
 
 
                                                                  

 

 
 
SKYPE 
 
http://support.skype.com/en_US 
© 2008 Skype Limited 
 
 
To start Skype 
If it's your first time opening Skype: 

Open Skype on your computer. 
That means double-clicking this icon on your desktop or choosing it from the Windows > Start 
menu. Having trouble? Launch it from here. This will open a start-up screen.  

Click Don't have a Skype Name? 
This opens a Create account window.  

Type in your name, then create a Skype username (called a Skype Name) and a password. 
- Pick ones you can remember so you can sign in next time. 
- Follow the directions from there and click Sign in.  

 
If you've opened Skype before: 
Open Skype from your desktop or Windows > Start menu.  

In the start-up screen, click in the box under Skype Name and type it in. Then do the same 
for your password. 
(If you forget your password, click the Forgot your password? link and follow the directions from 
there.)  

This will sign you in to Skype, ready for you to use.  
 
Call someone who's on Skype 
Call someone in your Contact list: 
Click the Contacts button at the top of Skype.  

 



 
 
 
                                                                  

 

In the list, find the person you want to call. 
Click on them. (Remember - anyone with one of these beside them is on Skype so it's free 
to call. Anyone with one of these means it's a phone or mobile number and calls will cost you 
a little.)  

You will see their details in the main window. 
Click the green Call button. You should hear ringing. If you don't hear the other person or they 
can't hear you, click the call quality icon at the top of your call window.  

To hang up, click the red End call button.  

 
Useful things you can do on a call: 

• Mute – click this icon to mute your microphone so the other person can't hear you.  

• Hold – click on this icon to put the call on hold.  

• Turn video on – if you've got a webcam plugged in, click the green Video call button to make it a video call.  

Adding a contact 
• Search your email contacts to see who's on Skype  

• Add a specific person  

• Add a phone or cell phone number  

Search your email contacts to see who's on Skype: 
Click the Directory tab and click the link See friends who are already on Skype. 
You'll see an Add contacts screen.  

 

Under Check your email contacts, click in the checkbox(es) beside the email accounts you 
have. 
If you have a Yahoo account, type in your username and password then click Search email 
contacts. 
Skype uses your Yahoo login to check if your contacts are on Skype – it never saves it, ever.  



 
 
 
                                                                  

 

 

Wait for Skype to search your contacts. 
If Skype finds a match, it will list the friends who also use Skype.  

Click in the checkbox beside the people you want to talk to on Skype. 
Then click Add contact.  

Write an introduction message so they know who you are. 
Click OK to send. Depending on their security, you can IM them. When they accept your 
invitation, you will be able to see when they are online and call them, too.  

 
Add a specific person: 
Click the Directory tab and go to Find people.  

Click in the box and type in their name, email address or Skype Name. 
Click Search. Wait for Skype to search.  

In the list, find the person you're looking for. Check details like location and click this icon 
to double check it's them. 
Click on them, then click Add contact. This will open a Say hello window.  

Click in the message box and type an introduction message so they know who you are. 
Click OK to send. When they accept your invitation, you will be able to see when they are online 
and call them, too.  

 
Send instant messages (IMs) 
To IM someone: 
In your Contacts, find the person or group you want to message. Or in your Conversations list, 
find the message you want to pick up again.  

Click on the person/group or conversation.  

In the main window, click in the typing box. 
Type a message and click the blue send message button, or just press the Return key on your 
keyboard.  



 
 
 
                                                                  

 

 
If someone IMs you: 
If someone IMs you, your Conversations button will turn orange. 
Click on the button.  

You'll see a list of conversations. 
Find the IM you want to reply to and click it.  

In the main window, click in the typing box. 
Type a message and click the blue send message button, or just press the Return key on your 
keyboard.  

 
Useful things you can do in an instant message: 

• Group IM – click this button to add more people to the conversation.  

• Save a group IM – click this button to save the group in your contacts. When you need to pick up 
the conversation again, just click on the group instead of adding everyone in all over again.  


